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Request Lists 

 

Request Lists are a type of Inquiry that allow for a listing of appointment requests.  Request 
lists are different than regular inquiries because they display requests for appointments 
rather than the booked appointments.  

The requests for appointments can be generated automatically through an Order entered 
in PowerChart (refer to “Requests Generated Through Orders-to-Scheduling” section or 
through an action performed in the Scheduling Appointment Book.  For example, 
appointments placed in a “no show” status can automatically generate a reschedule 
request for the patient.  Requests can also be created manually in the Scheduling 
Appointment Book (refer to the “Manually Create a Request” section). 

The table below lists the standard Request List Queues that are available to all clinics. 

Request List Queue Description 

Appointment Reviews Automatically populated with review requests.  These 
requests are generated when the associated order in 
PowerChart is modified by the Provider. 

(Only to be used by clinics that schedule medication 
infusions such as MDC and Oncology.) 

Cancellation List Manually populated with patients who have a scheduled 
appointment but have requested an earlier appointment 
if one becomes available. 

Refer to the Cancellation List Quick Reference Guide for 
more information. 

Future Requests Automatically populated with requests that have been 
generated via an order (Referral, Follow-up or Procedure 
order). 

Manually generated requests can also be added to this 
list. 

Reschedule Requests Automatically populated with patients/appointments 
that have been No Showed or displaced due to a 
template change.  
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Triage List Manually populated with requests that have been 
moved over from the Future Request list. 

This list should be used by clinics that need to triage 
requests they receive via orders. 

Waitlist Manually populated with patients that could not be 
scheduled when the referral was received. 

This list is populated by manually generated Requests or 
by moving a Request from another queue such as Future 
Requests.  

 

 

Open a Request List  
Request lists are a type of Inquiry.  Therefore, the steps outlined in the Appointment 
Inquiry section could be used to open a Request List.  The following steps are used to 
access the Request List directly. 

1. Click on the Request List Inquiry icon located in the Toolbar.  The “Schedule Inquiry 
window” will open. 

 

2. The Inquiry field should default to “Request List by Location.”  Keep this Inquiry to run a 
Request List for a specific clinic.  The other Inquiries do not filter by Location so they could 
be very long. 

 

3. Select the appropriate Request List Queue (refer to the table above for a brief description 
of the most common Request Lists). 

4. Select the appropriate Location Type and select the appropriate clinic from the Location 
dropdown.  
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5. Click the Find button.  All appointment requests that meet the search criteria are 
displayed. 
 

 

 

Create a Request Manually 
Requests can be generated manually in the Scheduling application.  This option can be used 
for a variety of scenarios, but is most commonly used to: 

• Add a patient to the Waitlist 
• Add a patient to the Cancelation List 
• Add a patient to the Future Requests List until an appointment time can be 

confirmed 

By placing an appointment request, the information entered in the “Accept Format Fields” 
and any associated order information is saved for when the user comes back to finish 
booking the appointment. 

Complete the following steps to manually generate a request: 

 

1. Enter patient/appointment information into the Appointment tab (follow steps 4-18 in 
the Appointment Scheduling section - Drag and Drop Method). 

2. Click Move to move the appointment into the Work in Progress window. 

3. Click on the Request button.  The “Request for Book” window opens. 
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4. Enter the date and time range for the request (in section A) if the default values are not 
appropriate. 

 
 

5. In the Request List section (section B), the “Future Requests” queue will default into the 
“Selected request lists” window.  If the patient needs to be added to a different Request 
List, select the “Future Requests” list and use the left arrow  to remove it from 
the selected list. 

A 

B 
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6. To add the patient to a different request list, ensure the “Show all” checkbox is selected 

(at the bottom of the window) and scroll through the list to select the appropriate list.  

 

7. Once the appropriate Request List is selected, click the right arrow  to move it 
into the “Selected request lists”box. 

8. Click OK. 

 

Requests Generated Through Orders-to-Scheduling 

The “Orders to Scheduling” functionality allows for an automatic appointment request to 
be sent to Cerner Scheduling Management when an order is placed in PowerChart.  A 
scheduler can then view the request in their clinic-specific queue and schedule it 
according to the Provider’s instructions.  The Orders to Scheduling workflow can be useful 
in the following scenarios: 

• Clinic to Clinic: For example, a specialty clinic referral. 
• Discharge Follow Up: For example, an inpatient is discharged and is referred to a clinic to 

be seen as an outpatient. 
• Internal Clinic Follow Up: For example, after seeing a patient in the clinic the Provider 

requests a follow-up appointment. 
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Schedule an Appointment from a Request List 
1. Follow the steps outlined in the “Open Request List” section above. 
2. Right-click the person you want to schedule and select Complete Request.  

 
3. If the “Future/Requests/Appointments” window opens, click OK. 
4. The “Appointment Attributes” window will open if there are mandatory fields that have 

not been entered.  Fill in the fields and click OK. 
NOTE: Copy and paste the Ordering Provider into the Referring Provider field. 

 
5. The appointment opens in the WIP.  
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6. From this point, any of the scheduling methods can be used to complete the booking.  

However Suggest is recommended because the date range will default to the dates 
entered by the ordering Provider.  

 

Modify a Request 
From the Request List Inquiry, it is possible to modify the details associated with the 
request or the details associated with the appointment linked to the request. 

In order to modify details about the request (such as Scheduling Criteria), follow the steps 
below. 

 

1. Follow the steps outlined in the “Open Request List” section above. 

2. Right click on the Request and select “Modify Request.” 

3. Click on the Scheduling Criteria tab to change the requested date range and/or time of 
the Request. 

 
 

In order to modify details about the appointment linked to the request (such as “Accept 
Format Fields”), follow the steps below. 

1. Right click on the Request and select “Modify”. 
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2. Click on the Details tab to edit the “Accept Format Fields.” 

NOTE: This is where comments can be entered for waitlisted patients. 

 
 

Move a Request 
Follow the steps below to move a request from one Request Queue to another. 

 

1. Right-click on the appropriate Request and select Move Request.  The “Modify Request” 
window will open. 
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2. In the “Modify Request” window, select the Request List in the “Selected Request List” 
section and click the left arrow.   This will remove the Request from the current list.  

 
 

3. Select the Request List you would like to move the Request to (from the “All Request 
Lists” section) and click the right arrow.  

4. Click OK to move the Request to the new list. 

 



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 13 of 97 

Cancel a Request 
Follow the steps below to cancel a request from a Request Queue.  

NOTE:  Once a request is cancelled, it cannot be un-cancelled.  If a request is cancelled 
in error, a new request must be created either from the Scheduling Appointment Book 
or from an order in the PowerChart. 

1. Right-click on the appropriate request and select Cancel Request.  The “Cancel” window 
will open. 

 

2. Select a “Cancel reason” from the drop down menu and click OK to remove the Request 
from the List. 
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Work Queue Monitor (WQM) 

With the CST implementation, all paper referrals and documents that are faxed to a 
clinic will be accessed in Work Queue Monitor (WQM).  Faxes will no longer be printed 
on paper.  

Work Queue Monitor (WQM) is a document management solution that enables 
scanned/faxed documents to be routed to specific queues for review.   From WQM, you 
can associate documents to patients and visits, making them available in the patient’s 
chart.  This will streamline departmental processes by automatically populating work 
queues for processing and also eliminate the need to print and scan documents.  

Below is a screenshot of the Work Queue Monitor home page.  

 

A. Menu Bar: Includes Task, Work Item, View and Help options. 

B. Toolbar: Includes buttons or other window elements (such as Refresh, Open, Route, Fax, 
Delete, New and Edit options). 

C. Clinic WQM Queues: Each tab is for individual clinic’s WQM queue.  When a new fax is sent 
in, it goes directly to a specific clinic’s WQM queue. 

A 
B 

C 

D E 

F 

G 
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D. A List of all Faxes: Displays all the faxes received in a specific clinic with information on 
date/time, status, owner, encounter type etc. 

E. Faxed Document Image: Displays the image of the fax sent to a clinic when a document is 
selected from the list of faxes.  

F. All Page View Bar:  Displays each page of a document separately on the right hand side of 
the screen.  By clicking on a specific page number, the page displays in the faxed document 
image area. 

G. Task Bar: Includes functions such as Printer, Scanner, Page Navigation, Copy, Zoom in/out 
etc. 

 

Open a Document in WQM 
Follow the steps below to open a faxed document in WQM: 

1. Log into CDI Work Queue Monitor.  

2. Click on the appropriate clinic queue/tab. 

3. Double-click on the appropriate row in the queue to open the “Add/Modify Work Item” 
window.  

 

Print a Document from WQM 
1. Click on the document that you would like to print. 
2. Click on the Printer icon located at the bottom-right side of the screen. 

 
3. Find the appropriate printer and click OK to print. 

 

Link a Document to a Patient/Encounter 
1. With the referral open in the “Add/Modify Work Item”, click on the Select Patient icon. 

 
2. Search for the patient by entering the PHN then click OK (if you do not have a PHN, 

search by partial Last Name and First Name or Date of Birth and Gender). 
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3. If you have found the correct patient, click only ONCE on their name to select, then click 
Add Encounter. 

NOTE:  The patient may already have an existing encounter that is appropriate for this 
document to be attached to.  For instance, if information is arriving after the original 
referral package was received, there may already be a Referral encounter.  If an 
appointment was already booked, there could be a Pre-Outpatient encounter.  In this 
case, you would select an existing encounter from the Encounter list. 

 
4. The “Organization” window appears.  

5. Enter the “Facility Name” in Organization window and click OK. 

6. The EMPI window briefly launches to open the “Referral Management” conversation 
window. 

7. Click the Encounter Information tab to complete the below mandatory fields: 

Encounter Type: Referral (auto-defaults) 
Medical Service: Select an option from the list 
Reason for Visit: Add a reason for visit 
Referring Provider: Select a Referring Provider  

8. Click the Referral Info tab to complete the below mandatory fields: 

Referral Received Date: Type “T” for today’s date 
Referral Status: Select an appropriate status from the list 

NOTE 1: Selecting a Referral Status of “Ready for Triage” drops the patient to the 
Triaging Provider’s Dynamic Worklist in PowerChart for review.  

NOTE 2: If there are additional steps that are required before sending the referral to 
Triage, set the Referral Status to “Referral Received”. 
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9. Click the Complete button to close the “Referral Management” conversation.  

10. The “Referral Management” window opens with an Encounter Number and Visit ID.  

11. Click OK to close the “Referral Management” window.  

 

Index a Document in WQM 

All documents received in WQM must be indexed with an appropriate Document Type and 

Status so they are stored appropriately in the Patient’s chart. 

1. If sufficient information is provided to link the document to a patient/encounter, it is 
appropriate to “Complete” the document.  This will take it off the queue and save it in 
the patient’s chart.  

i. In order to complete indexing, enter the below fields in “Add/Modify Work 
Item” window and click OK.   

Document Type: Choose the appropriate option from the list 

Status: “Complete” 

Performing Provider: Document, Scanned 

 
2. If there is not enough information to complete the document, the status should be set 

to “Clarify.”  This will keep the document in the queue until sufficient information is 
obtained. 

i. Enter the below fields in the “Add/Modify Work Item” window and click OK.  

Document Type: Choose the appropriate option from the list (it is 
possible to leave this field blank if the type is not known) 
Status: “Clarify” 
Reason: Choose the appropriate reason [for example: select “insufficient 
information/Incomplete” if the patient’s name is not listed, select 
“missing pages” if an order is missing, or select “poor quality” if the 
reports are illegible etc.]  
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ii.  The below “pop-up” window may appear.  Click Yes to continue. 

 
 

NOTE: Contact Records Management if you have indexed it to a wrong encounter/patient or 
forgot to select “Performing Provider: Document, Scanned” 

 

Scan a Paper Document to a Patient Chart 
Paper documents that are received or generated during a patient’s visit need to be attached 
to the patient’s chart.  This will be done by faxing the document to your own clinic queue. 

 
Follow the steps below to fax a document into WQM: 

1. From a fax machine, fax the document to the correct fax number for the clinic. 

2. Log into CDI Work Queue Monitor.  

3. Click on the appropriate clinic queue/tab. 

4. Double-click on appropriate row in the queue to open the “Add/Modify Work Item” 
window.  

5. With the referral open in the “Add/Modify Work Item,” click on the Select Patient icon. 
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6. Search for the patient by entering the PHN then click OK (if you do not have a PHN, 
search by partial Last Name and First Name or Date of Birth and Gender). 

7. If you have found the correct patient, click only ONCE on their name, select the 
Encounter for the patient’s current visit and select OK - do not create a new Encounter. 

 
 

8. In order to complete indexing, complete the below fields in “Add/Modify Work Item” 
window:  

Document Type: Choose the appropriate option from the list (it is possible to 
leave this field blank if the type is not known) 
Status: “Complete” 

9. Click OK to close the “Add/Modify Work Item” screen and the document will drop off 
the clinic’s WQM queue. 

10. All scanned documents are to be stamped “scanned” and bundled together daily with a 
Clinic Scanning Cover Sheet on top and forwarded to HIM (Health Records) for auditing 
and storage pre-destruction.  This includes any documents that were manually faxed 
into Work Queue Monitor as they follow the same processes as single document 
scanning.   

 
 

Delete a Document in WQM 
If a document on the queue is not appropriate to link to a patient’s chart, it can be deleted. 
Follow the steps below to remove the document from the queue. 

1. Right-click on the document that you would like to delete. 
2. Click Delete to remove the fax from the queue. 
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Split a Document in WQM 
 
When a multi-page fax is received that includes different documents types (ex:  Lab Results, 
Consent Forms, Imaging Reports, etc.), the clerk must “split” the document.  This involves 
dividing the document into different sections, linking them to a Patient/Encounter and indexing 
them with the appropriate “Document Type” in WQM. 

NOTE:  Another reason why you may need to split the document is that multiple referrals have 
been sent in one package for multiple patients.  You would need to split out each patient’s 
referral and link it to the appropriate patient and encounter. 

Follow the steps below to split a document into WQM: 
 

1. Follow the steps in the Link a Document to a Patient/Encounter section to link all pages 
of the received fax to a patient/encounter. 

 

In order to finish the indexing & splitting of the documents, complete the below steps in 
the “Add/Modify Work Item” window: 

 

2. In the “Add/Modify Work Item” window, select the first document preview located on the 
far top right-hand side of the screen then click the “Split” icon from the Toolbar 
(located at the bottom of the right-hand side of the screen).  The non-selected pages will 
be removed from the current work item and placed in a new work item, which will be 
processed later.  
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3. Process the current item by selecting the appropriate “Document Type” from the 

dropdown list and update the status to “Complete.” 

4. Click the  button in the lower left corner. 

5. The “Maintain Information” window will appear.  If the documents are for the same 
patient, then select “Maintain Patient Context,” if the next document type is also the 
same, select “Maintain Document Type and Subject.”  Click OK.  

 
NOTE 1: If the next document is for a different patient, unselect the “Maintain patient 
context” checkbox and follow the steps outlined in “Link a Document to a 
Patient/Encounter” to link to a different patient/encounter. 

NOTE 2: If the next document is a different type, do not select the “Maintain document 
type and subject” checkbox.  The appropriate Document Type should be selected in the 
“Add/Modify Work Item” window.   

 

6. Continue to split documents until all the documents are processed.   

7. Click OK to close the “Add/Modify Work Item” screen.  

8. The referral will drop off the clinic’s WQM queue. 
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Re-Routing a Document to another Clinic in WQM 
 

Queues in WQM are the equivalent of fax lines.  It is therefore possible for a document to end 
up on the wrong clinic queue.  Follow the steps below to re-route the document to the 
intended clinic. 

NOTE: It is good practice to notify the Referring Provider of the error so it is not repeated. 

1. In the “Add/Modify Work Item” window, select the correct clinic queue from the Queue 
Routing drop-down list. 

 

 
 

2. Click OK to close the “Add/Modify Work Item” window. 

3. Click the Route icon on Toolbar to forward it to the correct clinic queue. Once it has 
been re-routed, it should fall off the original queue. 

 
 

Reorder Clinic Queue/s in WQM 
1. Go to View and click on Order Queues. 

 



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 23 of 97 

 
 

2. Clinic on the clinic name that needs to be moved up. 

 
3. Click on Top (to move it to the very beginning) or Up button (to position it in the 

right order) to reorder. 

 

 



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 24 of 97 

Multi-Patient Task List in PowerChart  
Once a review of the referral has been completed by the Triaging Provider/Clinician, one 
of the following three orders will be entered in PowerChart to communicate the next 
steps to the clerk: 

• Accept Referral 
• Reject Referral 
• Referral Information Request 

The order will cause the patient to display on the clerk’s Multi-Patient Task List (MPTL) 
in PowerChart.  From the MPTL, it is possible to view order details, task status, open the 
patient’s chart and complete a task with a date and time stamp.  

 

Setting up the MPTL 
 The Multi-Patient Task List (MPTL) must be set up by each user the first time they log 

into PowerChart.  Follow the steps below to set-up (or modify) the MPTL: 

1. From the “Multi-Patient Task List” window, right-click on the “(no time frame defined)” 
area on the grey bar and select “Change Time Frame Criteria.” 

 
 

NOTE: If an MPTL has already been set up and you need to make a modification, right-
click on the “Departmental View, Assigned Tasks” area on the grey bar and select 
“Customize Patient View.” 

 
 

2. The “Task List Properties” window will open.  Click on the Time Frames tab. 
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3. Set a wide time range to include all tasks (it is suggested that the From: date be set to 
two months in the past and the To: date be set to the year 2100). 

 

4. Click on the Patient List tab, find and select the appropriate clinic location in the 
Location Filters and click OK. 
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Managing the MPTL 
Follow the steps below to open the Multi-Patient Task List and complete a Task. 

1. Log onto PowerChart.  

2. Find Multi-Patient Task List icon on the Toolbar and click on it. 

 
 

3. A list of patients who have been triaged will appear.  The “Task Description” column will 
indicate which order was submitted by the Triaging Provider/Clinician.  

 
NOTE: Click on the Refresh button frequently to view the updated tasks coming from 
PowerChart. 

There are three types of tasks that will be displayed on the MPTL: 

6. Accept Referral: When a Provider places an Accept Referral Order in PowerChart, an 
Accept Referral task is generated in MPTL.  

i. Next Step: Based on the accept referral order, the scheduler can either book an 
appointment or add the patient to the waitlist. 

NOTE: When a Provider places an “Accept Referral” Order in PowerChart, the 
patient drops off the Provider’s Dynamic Worklist and the system auto updates 
the Referral Status to “Accepted.”  

7. Reject Referral: When a Provider places a Reject Referral Order in PowerChart, a Reject 
Referral task is generated in MPTL.  

i. Next Step: Based on the reject referral order, the scheduler will follow-up with the 
Referring Provider (clinic dependant) and discharge the referral encounter with an 
applicable discharge disposition. 
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NOTE: When a Provider places a “Reject Referral” Order in PowerChart, the 
patient drops off the Provider’s Dynamic Worklist and the system auto-updates 
the Referral Status to “Rejected.” 

8. Referral Information Request: When a Provider places a Referral Information Request 
Order in PowerChart, a Referral Information Request task for missing information is 
generated on the MPTL.  

i. Next Step: Based on the referral information request order, the scheduler will 
follow-up with the Referring Provider or patient to get the missing information. 
When the new information is received, it must be indexed to the same 
patient/encounter in WQM and the Referral Status must be set back to “Ready for 
Triage.” 

NOTE: When a Provider places a “Referral Information Request” Order in 
PowerChart, the patient drops off the Provider’s Dynamic Worklist and the 
system auto-updates the Referral Status to “Pending.” 

4. Once you are done completing any of the above “Next Steps,” right click on the task that 
you just completed on MPTL and click on Chart Done (Date/Time). 

 
5. Click on OK button on the Referral (Chart Done) window to complete a task. 

 
6. A Check mark appears next to the “complete” task.

 
7. Click on the “Refresh” button to make the task drop off the MPTL.
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Referral Encounter Worklist in PMOffice 
Referral Encounter Worklist in PMOffice displays a list of all the open referral 
encounters for a selected location.  The various functions performed by a scheduling 
clerk in this worklist are reviewed below. 

Open the Referral Encounter Worklist 

1. Log onto PMOffice   

2. Click on the Worklist tab and double-click on the Referral Encounter Worklist 
 

3. In the “Filters: Referral Encounter Worklist” window, select a clinic location (expand the list 
to select the clinic name prefixed with wheelchair sign). 

 
4. Click the Copy button to move the clinic to selected box and click OK. 

5. A list of the open referral encounters for this clinic is displayed. 

 
 

Update Referral Status 

When the status of Referral encounter needs to be updated, the clerk updates referral 
status using Referral Encounter Worklist. 

6. With the Referral Encounter worklist open, right-click on the patient name and click 
“Referral Management” to open the conversation. 
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7. Click on Referral Info tab and select a new Referral Status from the drop-down list. 

 
8. Click Complete. 

 

Discharge Referral Encounter 

When a referral encounter needs to be discharged because of cancellation or rejection, the 
clerk can discharge the encounter using Referral Encounter Worklist. 

9. With the Referral Encounter worklist open, right-click on the patient name and click 
Discharge Encounter to open the conversation. 

 
 

10. Update Referral Status, Discharge Disposition, Discharge date and Discharge Time. 
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11. Click Complete to complete the discharge and close the window. 

 

Change Referral Encounter to Pre-Register Outpatient 

When a Referral is ready to be scheduled, the clerk books the appointment with the 
Referral encounter.  The encounter is then flipped from Referral to Pre-Outpatient using the 
Referral Encounter Worklist.  

It is vital that the encounter be updated to Pre-Outpatient so that it can be checked in 
appropriately when the patient arrives.  Also, if the encounter type is left as Referral, the 
encounter will not appear in the “Past Due Arrivals” worklist. 

 

1. With the Referral Encounter worklist open, right-click on the patient name and click Pre-
Register Outpatient to open the conversation. 

 
 

2. The EMPI window briefly launches.  

3. Click Encounter Information tab to select Pre-Outpatient in Encounter Type drop-down list 
and update Referral Status to Accepted. 

  
4. Click Complete button and the “Document Selection” window pops-up. 

5. Click OK to close the “Document Selection” window. 

6. The Referral encounter drops off the Referral Encounter Worklist.  
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Referral Triage – At a Glance  
Referral Triage is the process by which clinicians/Providers determine if and/or when a 
newly referred patient will be seen in an outpatient clinic.  This includes receiving the 
referral, triaging and booking the appointment.  

Below is a high-level workflow for processing a referral received both from an internal 
(CST site) and external (non-CST) site.  The workflow includes receiving the referral, 
creating the referral encounter, sending it to the Triaging Provider and scheduling the 
appointment.   

 

 

Figure 01: Referral Triage – Internal and External 

 

NOTE: External Sites are the sites that are not using CST Cerner and Internal Sites are 
the sites that are using CST Cerner.  

 



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 32 of 97 

External Referral Triage 
The External Referral Triage process is initiated when a Provider/Clinician faxes a referral 
form to a clinic. The faxed referral form will automatically generate an item in Work Queue 
Monitor (WQM) that will be routed to a specific queue for review. 

The clerk in the receiving clinic will find the new referral on their WQM Queue, link it to a 
patient/encounter and index it to send the referral to the Triaging Provider.  Once the 
referral is reviewed, the clerk will be notified of the decision via a task on their Multi-
Patient Task List.  At this point the referral can be scheduled, waitlisted or rejected based 
on instructions from the Triaging Provider. 

Follow the steps below to process an external referral that requires triaging. 

 

Process a Referral in WQM 
1. Refer to the “Open a Document in WQM” section to open the faxed Referral form. 

2. Refer to the “Link a Document to a Patient/Encounter” section to associate the faxed 
Referral form to the appropriate patient/encounter. 

NOTE: When the Referral Status is set to “Ready for Triage” (in the Referral encounter) the 
patient will appear on the Triaging Provider’s Dynamic Worklist.  Ensure that the Referral 
is indexed in WQM at this point otherwise the Provider will not be able to view the 
document in the PowerChart. 

3. Refer to the “Index a Document in WQM” section to specify the document type and 
status. 

The referral has now been sent to the Triaging Provider for review.  The Provider’s 
decision regarding next steps will be communicated via an order that will trigger a task. 
Clerks must monitor the Multi-Patient Task List (MPTL) in PowerChart where the tasks can 
be viewed. 

 

Process a Task on the MPTL in PowerChart 
4. Refer to the “Managing the MPTL” section to open the Multi-Patient Task List and 

complete the Task. 
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Accepted Referrals 
5. When an Accept Referral order is entered by the Triaging Provider/Clinician, the clerk will 

schedule an appointment or add the request to the Waitlist depending on the Clinic’s 
practice. 

Schedule Appointment 
i. Refer to the Appointment Scheduling section to book an appointment.  Use any of 

the three scheduling methods. 
• When performing the Person Search (step 4), select the patient AND the 

Referral encounter before clicking OK.  By doing this the appointment will 
be linked to the existing Referral encounter. 

 

ii. When the appointment is scheduled in a Pending state, click on the Confirm 
button. 

iii. Click OK in the “Confirm” window. 
• Since the appointment is already linked to the Referral encounter, the 

Encounter Selection window will not open. 
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iv. Follow the steps in the “Change Referral Encounter to Pre-Register Outpatient” to 
update the encounter. 

Waitlist Appointment 
i. Refer to the “Create a Request Manually” section to add the patient to the Waitlist 

Request queue. 
ii. When it is time to move the patient from the waitlist into an appointment, follow 

the steps in the “Schedule an Appointment from a Request List” section. 

 

Rejected Referrals 
6. When a Reject Referral order is entered by the Triaging Provider/Clinician, the clerk will 

notify the Referring Provider (clinic dependant) and discharge the Referral encounter.  
i. Follow the steps in the “Discharge Referral Encounter” section to discharge the 

encounter. 

 

Referrals Requiring More Information 
7. When a “Referral Information Request” order is entered by the Triaging Provider/Clinician, 

the clerk will follow-up with the Referring Provider or patient to get the missing 
information.  When the new information is received, it must be indexed to the same 
patient/encounter in WQM and the Referral Status must be set back to “Ready for Triage.” 

Process Additional Documents in WQM 
i. Additional information should be sent in via fax so an electronic version can be 

linked to the patient’s chart.  If the additional information is received on paper, 
follow the steps in “Scan a Paper Document to a Patient’s Chart” to get the 
document into WQM. 

ii. When the requested information is received in WQM, follow the steps in the “Link 
a Document to a Patient/Encounter” section to link the document(s) to the existing 
patient and Referral encounter. 

iii. Follow the steps in the “Index a Document in WQM” section to link the document 
to the appropriate Document Type. 

Update Referral Encounter 
iv. Once the additional documents have been saved to the appropriate 

patient/encounter, follow the steps in the “Update Referral Status” section to 
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change the status back to “Ready for Triage.”  This will cause the patient to re-
appear on the Triaging Provider’s Dynamic Worklist. 

Additional Referral/Triage Scenarios 
 

Scenario 1: Fax is received with insufficient information for triage.  
The Clerk will follow-up with the Referring Provider for additional details prior to sending it to 
triage.  

1. With the referral open in WQM, the clerk identifies some missing information.  

2. The Clerk contacts the Referring Provider to request additional information. 

3. Follow steps 1 through 7 in Scenario 1 to begin linking the referral form to a 
patient/encounter.  

4. Click the Referral Info tab to complete the below mandatory fields: 

Referral Received Date: Type “T” for today’s date 

Referral Status: Select “Pending” from the list 

5. Click the Complete button to close the Referral Management conversation.  

6. The “Referral Management” window opens with Encounter Number and Visit ID.  

7. Click OK to close the “Referral Management” window.  

8. Complete the below fields in “Add/Modify Work Item” window:  

Document Type: Select an appropriate option from the list 

Status: “Clarify” 

Reason: Select a reason from the list of options 

9. Click OK to close the “Add/Modify Work Item screen.” 

NOTE: the referral remains on clinic’s WQM queue with the status of “clarify.” 
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10. When additional information from the Referring Provider is received in WQM, double-
click on the new queue item to open the “Add/Modify Work Item” window. 

11. Click on the Select Patient icon.  

12. Search for the same patient by entering the PHN then click OK (if you do not have a 
PHN, search by partial Last Name and First Name or Date of Birth and Gender). 

13. Select the patient in the search results, select the existing Referral encounter in the 
window below and click OK. 

  

 
14. In order to complete indexing, fill in the below fields in the “Add/Modify Work Item” 

window:  
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Document Type: Select an appropriate option from the list 

Status: Complete 

15. Click OK to close the “Add/Modify Work Item” screen.  The referral will drop off the 
clinic’s WQM queue because the status was set to Complete. 

16. Go back to the clinic queue to update the original faxed referral.  Double-click on it to 
open the “Add/Modify Work Item” screen.  Change the Status to “Complete” and click 
OK to have it drop off the queue. 

17.  The final step is to update the status of the Referral Encounter.  This must be done in 
PMOffice.  Follow the steps below. 

a. Log into PMOffice and open the Worklist section. 

  
b. Double-click on the Referral Encounter Worklist.  

c. In the Filters window, select the appropriate Facility Name, click the 

 button and click OK. 

d. Find the patient on the list, right-click and select Referral Management. 

e. In the Organization window, enter the first few characters of the clinic name 
into the “Facility Name” field and click enter. 

f. Select the appropriate Facility from the list and click OK. 

g. The Referral Management window will open.  Click on the “Referral Info” tab 
and change the Referral Status to “Ready for Triage” and click Complete.  This 
will send the patient/referral to the Triaging Provider.  

 



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 38 of 97 

Scenario 2: Fax is sent to the incorrect queue.  

While reviewing the faxed referral in the “Add/Modify Work Item” window, the clerk identifies 
that the fax has been sent to the incorrect queue.  Follow one of the two options below to have 
the referral forwarded to the correct clinic.  

 Option 1: Re-Route the referral to the appropriate queue (this is only an option of the 
clinic the referral should be re-routed to has a queue in WQM) 

4. In the “Add/Modify Work Item” window, select the correct clinic queue from the Queue 
Routing drop-down list. 

 

 
 

5. Click OK to close the “Add/Modify Work Item” window. 

6. Click the Route icon on Toolbar to forward it to the correct clinic queue. 

 
 

 Option 2: Notify Referring Provider of the error and link the referral to an encounter 
that will be discharged. 

1. Follow the steps (1 to 7) from the “Link a Document to a Patient/Encounter” section. 

2. Click the Referral Info tab to complete the below mandatory fields: 

Referral Received Date: Type T for today’s date 
Referral Status: Select Cancelled from the list 
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Cancelled Reason: Select an option from the list 

3. Click the Complete button to close the Referral Management conversation.  

4. “Referral Management” window opens with Encounter Number and Visit ID.  

5. Click OK to close the “Referral Management” window.  

6. In order to complete indexing, enter the below fields in “Add/Modify Work Item” 
window and click OK.  

Document Type: Choose the appropriate option from the list 

Status: “Complete” 

7. Log into PMOffice and open the Worklist section. 

 
8. Double-click on the Referral Encounter Worklist  

9. Select the appropriate Facility Name, click the  button and click OK. 

10. Find the patient on the list and right click to select Discharge Encounter. 
 

 
11. Enter the below fields to complete the discharge of the encounter 

Discharge Disposition: no further service 
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Discharge Date: type “T” for today’s date 
Discharge Time: type “N” for current time 

 
12. Click Complete to close the “Discharge Encounter” window and the patient drops off the 

Referral Encounter Worklist.  

13. Notify the Referring Provider of the error and have them send it to the appropriate 
clinic. 
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External Referral without Triage 
 

The “External Referral without Triage” process involves receiving a new referral on a 
WQM queue, booking or wait-listing the request in SchApptBook (depending on clinic 
practice) and completing the indexing of the document in WQM with the appropriate 
encounter.   

Refer to the “Open a Document in WQM” section to open the faxed Referral form.  If the 
patient can be scheduled right away, refer to the steps in Option A below.  If the patient 
has to be added to a waitlist, refer to the steps in Option B below.  

 

Option A: Schedule an Appointment 

i. Keep the Referral form open for reference and open the SchApptBook. 

ii. Follow the steps in the “Appointment Scheduling” section to book an appointment 
using any of the scheduling methods with a “Pre-Outpatient” encounter.  

a. NOTE:  Similar to External Referral with Triage process, the clerk still has the 
ability to create a “Referral” Encounter in WQM, link it to a 
patient/encounter, index it, book an appointment with that Referral 
Encounter and flip it to Pre-Outpatient Encounter.  However, it is 
recommended that clinics that do not triage and book appointments directly, 
after receiving a referral in WQM, should go to SchApptBook to book an 
appointment with a “Pre-Outpatient” encounter.  Then they will go back to 
WQM to index the referral, linking it to that Pre-Outpatient.  This will save 
some unnecessary steps in processing referral requests for these particular 
clinics.  

Process the Referral in WQM 

iii. With the referral open in the “Add/Modify Work Item”, click on the Select Patient 

icon.  

iv. Search for the patient by entering the PHN then click OK (if you do not have a PHN, 
search by partial Last Name and First Name or Date of Birth and Gender). 

v. If you have found the correct patient, click only ONCE on their name to select, then 
select the existing “Pre-Outpatient” encounter from the Encounter List and click OK.  

vi. Refer to the “Index a Document in WQM” section to specify the document type and 
status. 
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Option B. Add Patient to the Waitlist  

i. Follow the steps in “Link a Document to a Patient/Encounter” to create a Referral 
Encounter in WQM. 

ii. Follow the steps in “Index a Document in WQM” to complete indexing of the referral 
request. 

iii. Follow the steps in “Manually Create a Request” to move the request to waitlist 
queue in SchApptBook. 
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Internal Referral Triage - Orders to Scheduling  
 

The Internal Referral Triage process is initiated when a Provider/Clinician enters a referral 
order in PowerChart.  The referral order will automatically generate a request that will fall 
onto the selected clinic’s “Future Requests” queue. 

The clerk in the receiving clinic will find the new referral on their Request List, create an 
encounter and move them to a “Triage List” queue until they receive instruction from the 
Triaging Provider/Clinician. 

Follow the steps below to process an internal referral that must be triaged. 

Open the Future Requests List 

1. Refer to the “Request Lists - Open a Request List” section to open the Future Requests 
list for your clinic. 

 
 

Link Request to a Referral Encounter 

2. Right-click on the request and select Modify. 

 
 

3. The Modify window opens.  
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4. Click the Set Enc button. 

5. The “Encounter Selection” window opens.  Click the Add Enc button.  

6. Select “Referral Management” conversation from the Available Conversations list and 
click OK. 

 
7. The “Organization” window opens.  Select the appropriate Facility Name and click OK. 

8. The “Referral Management” conversation window opens up.  Complete the mandatory 
fields in Encounter Information tab: 

Encounter Type: Referral (pre-populated) 

Medical Service: Select one from the list 

Referring Provider: Select one from the list 

9. Complete the mandatory fields in Referral Info tab and click Complete: 

Referral Received Date: Date the request was received 

Referral Status: Ready for Triage 

NOTE 1: Selecting “Referral Status: Ready for Triage” drops the patient to the Triaging 
Provider’s Dynamic Worklist in the PowerChart to review.  
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NOTE 2: If there are additional steps needed to be completed before sending the referral 
to Triage, set the Referral Status to “Referral Received.” 

10. Click OK to close “Referral Management window.” 

11. Click the Details tab in the “Modify” window and complete the mandatory fields. 

Referring Provider: Copy and paste the Ordering Provider 

Interpreter Required: Select one from the available options  

 

NOTE: Some fields are pre-populated from the order placed in the PowerChart. 

 

Move a Request to the Triage List Queue 

12. Follow the steps in the “Request Lists - Move a Request” section to move the request 
to the Triage List queue. 
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Manage Multi-Patient Task List in PowerChart 
The patient will remain on the Triage List until the Triaging Provider/Clinician reviews 
the referral and decides if/when the patient will be seen.  The Scheduling Clerk will be 
notified of the decision via an Accept/Reject/Information Request order.  When the 
order is entered it will drop a task to the clerk’s Multi-Patient Task List. 

Follow the steps in “Managing the MPTL” section to open the MPTL and view the open 
tasks.  

13. Assuming the Provider places an Accept Order request, the scheduler can book an 
appointment in SchApptBook. 

NOTE 1: If a patient must be put on a Waitlist, follow the steps in the “Move a 
Request” section to move the request to the Waitlist queue. 

NOTE 2: If the referral is rejected, follow the steps in the “Cancel a Request” section to 
remove the request from the Triage queue.  The schedulers must also follow-up with 
the Referring Provider (clinic dependent) and discharge the referral encounter with an 
appropriate discharge disposition. 

14. Once the appointment is booked, mark the task in MPTL as Chart Done (Date/Time). 

 

Completing a Request from Request List 

15. Follow the steps in “Requests Lists – Open a Request List” to open the Triage List 
queue. 
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16. Right-click on the request and select Complete Request. 

 
 

17. Click OK to close the “Future Requests/Appointment” window. 

18. The appointment request moves to the WIP area. 

19. From this point, any of the scheduling methods can be used to complete the booking. 
However Suggest is recommended because the date range will default to the dates 
entered by the ordering Provider. 

20. Once the appointment is scheduled in a pending status, click on the Confirm button. 

21. Confirm the appointment details and click OK.  The window will close and the 
confirmed appointment will be linked to the existing Referral encounter. 

 

Update Referral Encounter to Pre-Register Outpatient 

22. Follow the steps in the “Change Referral Encounter to Pre-Register Outpatient” section 
(under Referral encounter Worklist in PMOffice) to flip the Referral encounter to Pre-
Outpatient.  

NOTE: If it is important to your clinic to capture the date/time the appointment was 
booked, update the Referral Status field to “Booked” when updating the encounter. 

 



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 48 of 97 
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Locks 
Sometimes a slot will become locked when a user has tried to schedule an appointment to 
the slot, but for whatever reason it was not completed.  The slot may appear open, but it 
will not allow you to book an appointment.  If you get a warning that a slot is locked, look 
to see who the conflict was created by, then have that person unlock the slot.  

 

If the user that holds the lock is already logged into SchApptBook, the user can remove 
their lock(s) by completing the following steps. 

Locate the lock by clicking the “View Locks” icon.   A window will display listing all locks 
created by the account you are signed in with. 

 

Click Booking to see if the slot was a booking lock.  If there are locks which you would like 
to remove, highlight them and press the REMOVE button.  
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If you don’t see a lock in Booking, click In-Process Appointments to see if there is a lock in 
there.  Highlight any “In Progress” locks and press the REMOVE button. 

You may also need to release any verified locks.  To accomplish this, click the checkbox next 
to Show Verified Locks in the bottom left corner of the window. 

 

Checking Locks on Startup and Removing Other Users Locks 
When you log into SchApptBook, the Locks window will display immediately if you hold 
any locks.  You can remove the locks following steps 2-4 listed above. 

 

If you are unable to book an appointment because a lock has been created by another 
user, try to contact the user directly or call Helpdesk to have the lock removed.  
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Viewing Appointment Details 
In order to view specific details associated with an appointment, click the appointment 
inside the Appointment Book.  Once that appointment is selected, select Inquiry, 
Appointment View from the menu.  This will open the “Appointment View” window that 
displays specific information associated with the appointment. 
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Click on the different tabs to view the detailed information about the appointment.  
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Viewing Appointment History 
In order to view specific details associated with the history of an appointment, click that 
appointment in the Appointment Book. 

Once that appointment is selected, right click the appointment, and select Inquiry, then 
Appointment History View from the menu.  This opens the “Appointment History View” 
window that displays specific information associated with the states that have been 
associated with the appointment. 

 

The “History View” window will display. 

 

Click on the different tabs to view detailed information about the appointment.  
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Hot Keys 
In Appointment Book, there are several places where hot keys can be used. 

Pressing ALT + any underlined letter will perform that action the same as clicking with the 
mouse.  Below are several examples of actions that can be performed using hot keys. 

ALT+T: Opens the Task menu. 

 

From here it is possible to navigate through various actions like modify by using Shift+M or 
by pressing the up and down arrow keys.  Pressing TAB will move to the next menu, Edit, 
then to View and then to Help. 

NOTE: Actions will be available only if the user has clicked on an appointment in the 
appointment grid. 
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When scheduling an appointment, pressing ALT+A will move the cursor to the Appointment 
Type prompt, pressing ALT+P will move the cursor to the Person Name prompt, and so on. 
 

Within an Accept Format Field or an Order Entry Format: 

The TAB key will move the cursor to the next prompt. 

SHIFT+TAB will move the cursor back one prompt. 

Pressing ENTER with the pointer on an ellipsis, or any button is the same as clicking with 
the mouse. 

With the pointer on a prompt containing a list, the up and down arrows will scroll though 
the available options. 

ALT+M will perform the same action as clicking Move.  ALT+C will clear. 
  

 
  
Pressing ALT+W at any time will take the cursor to the WIP.  The up and down arrow keys 
navigate up and down the tree. 

Pressing ALT+S functions the same as clicking Schedule when ready to schedule. 
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Selecting Multiple Items 

There are several instances when selecting multiple items at the same time is necessary, 
such as selecting multiple appointments in the suggest window. 

Complete the following steps to select multiple items from a list: 

Highlight the first item to be selected in the list, hold down the SHIFT key, and press the 
down arrow key.  This will select one additional item at a time. 

Highlight the first item to be selected in the list, hold down the SHIFT key, and click another 
item in the list.  This will select the first item selected, the last item selected, and all items 
in between. 

Highlight the first item to be selected in the list, hold down the SHIFT key, and press the 
END key.  This will select the first item highlighted and all subsequent items all the way to 
the end of the list. 

Highlight the first item to be selected in the list, hold CTRL, and click any other items to be 
included.  This will select only the values that were clicked on while holding down the CTRL 
key.   
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Reports 
To Print Reports from the Scheduling Appointment Book, follow the steps below: 

1. Click on the Appointment Report Icon in the Toolbar.  

2. The Screen Below will appear: 

 

3. Select the appropriate tab (Person, Resource, Location or Request List). 

4. Select the desired report from the drop down box. 

5. Set filters of resource, person or location. 

6. If appropriate, set start and end date of report.  

7. Select the number of copies to print. 

8. Select printer from drop down box. 

TIPS: To set default printer in all screens, right click on the selected printer and select 
“Set as Default.” This will stick for the time that the user is logged onto the application. 
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Help Files 
When you have a question about how to use something in the scheduling appointment 
book, or you see a message or error that you don’t recognize, you can use your Help Files 
to search for the answers.   

The Help Files are accessed in the scheduling book by clicking Help in the Task Bar.  Then 
click HNA Help Topics.    

 
A Cerner Help Topics window will open.  Look for the topic by typing in the Search box.  

 
When you find the topic you are interested in, click on the link to read it. 
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Appendix A - Tips & Tricks 
 

Beginning of the day 

• Open “CDI Work Queue Monitor” and review/update work items 

 
• Open the “Future Requests” Request List Inquiry to see if there are any new referrals 

that you can Schedule (or move to a Waitlist/Triage list). 
• Open the Appointment Inquiry “Appt Check-In by Location” to prepare for checking-in 

patients. 
• Check “Past Due Arrivals” Worklist in PMOffice to cancel/discharge encounters linked to 

No Shows. 
• Check Deceased Report to review potential new vacant appointment slots (Weekly) 

Before You Leave For the Day 

• Check your locks, and remove all locks by clicking the Lock Inquiry Icon.  
• Review the Scheduling Grid to and see if you need to No Show any patients that were 

not Checked In. 
• Check the “Future Requests” Request List to see if there are any requests that can be 

Scheduled.  
• Check the “Reschedule Requests” to see if there are any appointments that should be 

rescheduled. 
• Check your Displaced Appointment list and see if there are any appointments that need 

to be shuffled back into slots. 
• Make sure you are logged out of all applications before leaving for the day. 

Bolded Calendar Days 

• Calendar days are displayed in bold type to indicate availability for the selected 
resource. 

• Remember that the appointment MUST be in the Work in Progress (WIP) in order for 
the system to determine available days. 

• This is set by clicking View > Options on the Appointment tab and selecting Mark 
Qualifying Days on Calendar. 
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Set Calendar 

• To quickly set the calendar, right-click anywhere on the calendar and choose the desired 
option from the drop down menu that is displayed. 

• You may set the calendar to a specific month, to the current day, the week's start, 
week's end, month's start, month's end, year's start, or year's end. 

• You may also use quick keys (noted under the screen shot below) to accomplish these 
settings. 

• These keystrokes may also be used within any date/time fields found within Scheduling 
Management. 

 

 
  

Quick Date Keys 
 

Use the T key to denote today's date in any date field. 
Press the N key to denote the current time in any time field. 
Use the W key to denote the beginning of the current week. 
Use the K key to denote the end of the current week. 
Use the M key to denote the beginning of the current month. 
Use the H key to denote the end of the current month. 
Use the Y key to denote the beginning of the current year. 
Use the R key to denote the end of the current year. 

 

Sizing Resources to the Screen 
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• To display these buttons, select the Action menu >Toolbars and select the Size toolbar. 
  

 
  

• On the toolbar are the sizing buttons that allow users to quickly expand or reduce the 
sizing of the resources and slots without clicking Book Settings > Properties. 

• Users can decrease column width, increase column width, increase slot size and 
decrease slot size. 

• When you exit and re-enter the application, the settings revert back to the default. 
• If you want the settings to be saved for the next time you enter the application, change 

the size options in the Book Settings > Properties View tab. 

Change View 

• You can change your view quickly by selecting the Change View icon on the toolbar 
without going into Book Settings > Properties. 

• You must have the View toolbar selected from the Action menu. 
• When you exit and re-enter the application, the setting is saved. 

  

 
  

View Patient Demographics 

• Double-click any appointment, and click the General tab. 

You also have the ability to customize the fields that display within the General tab. To 
modify this, right-click on any of the headers and select Preferences. From the Column 
Preferences window, you have the ability to select and reorder columns as appropriate. 
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Who Did What Concerning the Appointment (Appointment History View) 

If you would like to find out why a certain appointment was scheduled or canceled (or 
any action) this information is available at a click. 

Complete the following steps to access the Appointment History View: 
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• Find your appointment in the book or inquiry and right-click and select Inquiry > 
Appointment History View. This window lists actions performed on the appointment. 

• Click the Action History tab to see who performed which actions on the selected 
appointment. 

• If you would like to see the reason the action was performed, and any comments, click 
the Action Detail tab. 
  

 

 

Configuring the Tabs in Scheduling Appointment Book 

In Appointment Book, there are multiple places where you can configure the display and 
order of tabs. 

Complete the following steps to change tabs: 

• Right-click near the tabs and select Preferences. 
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• In the Preferences window, use the right and left arrows to select the tabs you want 
visible, and the up and down arrows to determine the order you want them to display. 
For example, if you want the Action History tab to display first, click Action History and 
press the up arrow until it shows first in the list. 

 

NOTE: This change is specific to only your username. 

 

Increase Viewing Size of the Grid 

Complete the following steps to increase the viewing size of the grid: 

To temporarily increase the viewing size of the Grid and hide the calendar, Appointment 
tab and WIP, click the date and resource time bar in the middle of the screen. Click the 
bar again (now at the top) to return to original settings. 
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See a Resource's Week or Month Schedule 

Highlight the resource you want to view and right-click, and select Book Settings > 
View > Week or Month*. A calendar-like view is displayed for that resource. The ability 
to change resources and dates are at the top of that window. 

 

Print Screen 

In any screen in the Appointment Book, you have the option to click Task > Print 
Screen and print that screen. Keep in mind that you have the ability to expand or 
collapse the Grid view. 

 

Scheduling an Additional Appointment for a Current Patient 

• From the Scheduling inquiry, right-click the patient appointment and select Add New 
Appointment. Appointment Details display with the patient name field pre-populated 
with the patient's name. 

• From there you can fill in the remaining fields and complete the scheduling process. 
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Appendix B – Advanced Tips & Tricks 
 

Performing Actions from the Toolbar, Task Menu, Grid, or Inquiry 

Within the Scheduling Appointment Book, there are multiple ways to perform actions on 
appointments: 

• Utilize the action icons located on the menu at the top of the screen. In order to see the 
action icons on the toolbar, you must have the Action toolbar selected from the Action 
menu. 

• Position the pointer over the icons to see what action they are used for. The information 
is displayed in a tooltip near the icon and also in the status bar at the bottom of the 
screen. 

• Use Task menu at the top of the screen 
• Right-click the appointment in the book and select Action. 
• Open Schedule Inquiry and search for appointments, then right-click the appointment. 

 

Selecting Multiple Resources When Using Resource Prompting 

• If Resource Prompting is being utilized, multiple resources can be selected through the 
prompt. To begin, select the first resource in the Prompting Resource Help box and 
click OK. 

 
• Your resource is defaulted into the field. Next, enter a semi-colon and the first letter of 

your next resource and press ENTER. 
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• The Prompting Resource Help window is displayed with your original resource. Click OK. 
  

  
 

• Next, an additional Prompting Resource Help box is displayed containing the resources 
from your Resource List with the letters entered. Select the needed resource and 
click OK. 
  

  
  

• Both resources are now are defaulted to the field. 
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Create List of Favorite Printers 

• For those that routinely print to more than one printer, a list of favorite printers can be 
created so that a single printer can be selected from a short list rather than from all that 
are built in the domain. 

• Printers added to a list of favorites in the Appointment Report window (and 
application), the Notification Report window, or the Report tab within the Itineraries tab 
of an action window can be accessed in all of those locations. 

• To add a printer to your list of favorites, ensure that the filter type is set to All by right-
clicking the printer list, and selecting Filter Type > All. Select the printer you want to add 
as a favorite, right-click it and select Add to Favorites. Continue selecting additional 
printers in this manner to add to your favorites list. After all desired favorite printers 
have been selected, right-click the printer list and select Filter Type > Favorites. The list 
displays only those that have been selected as favorites. 

  



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 69 of 97 

Appendix C – Patient Information Request (PIR) 
 

Create/Send a Patient Information Request 

1. Click the Patient Information Request icon  in SchApptBook.  

2. In the Profile: Patient Information Request window will appear. 

• Note that the fields marked with a red asterisk * are mandatory fields. 

• In the Facilities field, select the main hospital as the facility e.g. LGH Lions Gate 
Hospital and SGH Squamish General Hospital. 

 

3. In the Requester field, type the requester’s name (last name, first name), then click 

the Search button . The Provider Selection window will pop up. Highlight the 
correct requester and click OK. 

NOTE: The ‘Requester’ field may auto populate if you have the used this name in the 
past.  
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4. In the Patient Name field, type the patient’s name (last name, first name), the click 

the Patient Search button . The Patient Search window will pop up. Select the 
correct patient, and then click OK. 

NOTE: Health Information Management (HIM) Records Management will provide the 
latest volume of the paper record to the requesting location unless other volumes are 
specified in the request via notes.  
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NOTE: If you have the chart with a Cerner barcode label, you can scan the barcode in 
the “Visit Lookup” field under “Tracking ID” to identify the patient. Select “Enter”. 

 

The patient’s record will display at the bottom. 
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If the patient has been seen at more than one facility (i.e. LGH and SGH); this warning will 
display. Select ‘OK’ to bypass. 

 

5. To complete the Requesting location field, click on the Requesting Location button. 
The Location window will display. Select the correct location from the displayed list 
and click OK. 

 

NOTE: To save this location as your default, select the    option. 
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6. In the Request status field, leave the status as Logged.  

 

7. In the Request type field, select the appropriate request type (i.e. Patient Care), from 
the drop down selections. 

 

8. Enter the date/time that the chart/s are required. 

 

NOTE 01: If you are entering multiple requests, you can check the Maintain request 
information box, which will retain the requesting location and requester for future requests. 

NOTE 02: HIM's requirement is to have PIR request placed 24hours from the date and time 
the chart is required. If not within 24hours of required date and time the user is to phone 
Records Management to request the chart. 

9. Click on the Send Request button on the toolbar.  

10. The Note View Form window will pop up, enter a note if required and click the Save 

button . If no note is being entered, click on the Exit button . 



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 74 of 97 

 

11. If you checked the Maintain request information box, the PIR Request window will 
continue to appear and you can continue to request more patient charts (batch 
request) by populating the Patient name field and clicking the Send Request button 
until all of the charts that you need have been requested. 

 

Retrieve and Modify a Request 

1. In the PIR Request window, click the Get Request button  on the toolbar 
2. Type a request number. 

 

 

Note: The last request number can be found on the bottom of the screen. 
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3. Make the necessary changes. 

4. Click Modify Request toolbar button to save the changes. 

 

5. The ‘Note View Form’ opens, enter a note or click Exit .  

NOTE: Chart Request cut off time in 3Pm the day prior to the appointments 
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Appendix D – Single Document Scanning 
 

Work in progress  
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Appendix E – Appointment Book Icon Glossary 
 

  Action Toolbar: 

 
  Navigation Toolbar: 

   
 

Size Toolbar: 

   

  View Toolbar: 

   

  Application Toolbar: 

   
 

 

 
Icon Label Description 

 
Exit Closes the Appointment Book. 

 
Contact 

Records date and time of contact made with patient and is 
also a place to enter applicable comments concerning the 
contact. 

 
Modify Opens the Modify dialog box so you can modify the details 

associated with the appointment type. 

 
Reschedule 

When this option is chosen, the selected appointment is 
moved to the Work In Progress to be rescheduled to 
appropriate time and resource. 

 
Hold Changes the status of the appointment to hold so it can be 

completed at a later time. 

 
Cancel Cancels a scheduled appointment.  

 
No Show Indicates that a patient did not show up for their 

appointment. 

 
Check In Checks in the patient scheduled for the appointment. When 

this option is selected, the Check In dialog box opens. 

 
Check Out Checks out the patient to indicate that they have left the 

clinic. 

 
Patient Seen Marks the patient as seen in order to track the wait time for 

a patient’s appointment. 

 
Lock Locks the appointment so others cannot perform actions on 

it. 

 
Unlock Unlocks the appointment so others can perform actions on 

it. 
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Shuffle 

Opens the Appointment Shuffle Criteria box to move 
appointments on the same day, without having to go 
through all rescheduling steps. 

 
Swap Resources Moves all of the appointments from one Resource to 

another for a specified day. 

 
Create Group Session Creates a group session to be used for group appointments 

 
Link 

Links two or more appointments together for a patient to 
warn user if any action is performed on one of the linked 
appointments 

 
Unlink Unlinks appointments that were linked. 

 
Decrease Column Width Decreases the width of the columns within the scheduling 

grid. 

 
Increase Column Width Increases the width of the columns within the scheduling 

grid. 

 
Decrease Slot Size Decreases the slot size by modifying the time interval. 

 
Increase Slot Size Increases the slot size by modifying the time interval. 

 
Zoom In Increases the size of the scheduling grid. 

 
Zoom Out Decreases the size of the scheduling grid. 

 
Appointment View Opens the Appointment View dialog box so user can view 

details associated with the appointment. 

 
Appointment History View Opens a dialog box so user can view details associated with 

the appointment. 

 
Appointment Inquiry Opens the Schedule Inquiry window so user can launch a 

person, resource, or location inquiry. 

 
Request List Inquiry Opens the Request List tab of the Schedule Inquiry window 

so the user can launch a request list inquiry. 

 
Appointment Report Opens the Schedule Report window so the user can view or 

print person, resource, or location schedule reports. 

 
View Locks 

Opens the Locks Held By dialog box to display pending 
appointment information, which is locked in the system by 
the user. 

 
Change View Changes the view of the scheduling grid. 

 
Person Management Opens the Person Management application to search for a 

person in the database or to add a person to the database. 

 
Launches PMLaunch 

Opens the PMLaunch application and user selects the 
conversation you want to launch from the list in the 
Available Conversations dialog box. 

 
Show Allergies Opens the Allergy window so users can view allergy 

information for the selected patient. 



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 79 of 97 

 
Patient Information 
Request 

Opens the Patient Information Request window so user can 
request paper chart from Health Records. 

 Launch PowerChart Opens PowerChart, where user can view orders and 
documentation.  

 Back Takes user Back to the previous screen. 

 Forward Takes user Forward to the previous screen. 

 Refresh Updates the displayed information to reflect any changes. 

 What’s This Takes the user to a contextual help page. 

 
Request Information When in the Request List with an order selected, it displays 

details about the request. 
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Appendix F – Appointment Book Button Glossary 
 

BOOKS TAB: 

 Open Will Open the highlighted book on the bookshelf (double 
clicking the book performs the same task). 

 Select Allows user to Select a new Bookshelf. 
APPOINTMENT TAB: 

 Move Once all mandatory fields are completed in the accept 
format, the Move button places the event details in the WIP. 

 Next The Next button is used to proceed to the next appointment 
to be scheduled. 

 Clear The Clear button is used to clear the information displayed. 

 
No Known 
Allergies 

If a person has no allergies recorded, the NKA button will be 
displayed. 

 Allergies If a person has allergies recorded, the red button with the 
word Allergies is displayed. 

WORK IN PROGRESS: 

 Schedule Rather than drag and drop or suggest, a dialogue box 
appears for the user to Schedule the appointment.  

 Confirm Once the appointment is scheduled, select Confirm in the 
WIP box in order to confirm the request.  

 Recur Appointments can be scheduled to Recur by setting up a 
recurrence frequency. 

 Suggest Will Suggest times the appointment could be scheduled 
without requiring user to locate available slots manually. 

 Request Does not schedule appointment and instead adds it to a 
Request list. 

PERSON SEARCH: 

 Search Once the required search criteria are entered, select Search 
to find the patient in question. 

 Reset Select in order to Reset the entered criteria. 

 Preview To Preview a quick view of the patients registration 
information. 

 Add Encounter Select Add Encounter to create a new encounter when 
scheduling an appointment.  

 Modify To Modify and existing encounter, the Add/Modify Person 
conversation will open. 

 
MPI 

Search 
The MPI Search is used to ensure the user has the most up-
to-date demographic data for the patient. 
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Appendix G – Appointment Types Display Schemes  
 

APPOINTMENT TYPES DISPAY SCHEMES 
Appointment 

Status Definition Color Example 

Cancelled The appointment is cancelled and a cancellation 
reason is required. Red  

Checked In Checked in appointment. Green  
Checked Out Checked out appointment. Purple  

Confirmed An appointment that has been confirmed. Light 
Blue  

Hold An appointment that is on hold. Orange  

No Show Patients who did not present to their scheduled 
appointment Grey  

Pending  A pending appointment. Yellow  
Rescheduled An appointment that has been rescheduled. Blue  

Scheduled The spot is held, but the appointment is not yet 
confirmed 

Dark 
Green  

Secured User does not have the required security rights to 
view any information related to this appointment. Grey  
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Appendix H – Scheduling Demographic Bar  
 

 

Term  Definition  

Name 
The name that is supported by documentation such as birth certificate, 
passport or SIN (also known as Legal name). 

Preferred Name 
Name a person wishes to be addressed by or additional names the 
patient is known by. 

Disease Alert 

Disease Alerts are patient information around a disease process that 
should be quickly conveyed to users to prevent possible transmission of 
disease.  It may not otherwise be easily discovered and may harm the 
patient, care Provider, and/or the general population if not know.  (E.g.:  
Could include TB, MRSA, etc.) 

MRN 
Medical Record Number - Unique Clinical Information System number to 
represent a single client.  Also known as chart number. 

Process Alert 

An alert placed at the person level in registration - information that 
should be quickly conveyed to care Providers to prevent critical physical 
or mental harm to the patient or care Providers.  This information may 
not otherwise be easily discovered and may negatively affect the patient, 
care Provider, or others if not known. 

BC PHN 
BC Personal Health Number - Numerical lifetime identifier used in the 
specific identification of an individual client or patient who has any 
interaction with the BC health system.  

DOB 
Date of Birth - The calendar date on which a person was born as reported 
upon registration and displayed using the ‘Day-Month-Year’ format. 

Age 
Age is a derived variable that represents how old the patient is at the 
time of admission and is calculated using the Birthdate. 

Gender Gender is the patient’s identification as either male or female upon 
registration. 
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Language The language that patient speaks, if not English. 

Interpreter  
Required 

Identifies whether client requires an interpreter for communication.   If 
“No” is selected in the Interpreter Required field, staff must determine 
and enter in the Primary Language field what language the client is most 
comfortable discussing their medical condition in. 

Person Comments Non Clinical information is communicated to the scheduler. 

Location The location that the patient is registered to. 

Preferred Phone The preferred phone number to be contacted at. 
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Appendix I – Definitions 
 

Term Definition 

Accept Format Data fields specific to an Appointment Type, to assist in the collection of 
information at the time of appointment scheduling.  Accept formats are 
additional questions (required or optional) to be asked and answered at 
the time an appointment is scheduled.  

Adding Slots To add slots for a day, right click on the scheduling appointment book, 
select slots and the Add Slots. 

Admitting Provider The Admitting Provider is a member of the medical staff who has 
inpatient admitting privileges and has primary responsibility for the care 
of the patient at time of an inpatient admission. Recording the Admitting 
Provider is mandatory as per the Hospital Act and the information is 
reported to CIHI.  

Age Age is a derived variable that represents how old the patient is at the 
time of admission and is calculated using the Birthdate. 

Appointment  A period of time booked for a patient or resource during which a specific 
activity will take place. Activities can be described by the selected 
appointment type or the textual appointment description. 

Appointment Book Provide schedulers a logical grouping of resources.  As a user, they can 
access an Appointment Book which will present all the resources within 
the book to provide a quick and easy view of the resource availability and 
scheduled appointments. 

Appointment 
Details 

In order to view specific details associated with an appointment, click the 
appointment and select Inquiry, Appointment View from the menu.  This 
will open the Appointment View dialog box that displays specific 
information associated with the appointment. 

Appointment 
History 

In order to view specific details associated with the history of an 
appointment, right click the appointment, and select Inquiry, then 
Appointment History View from the menu. This opens the Appointment 
History View Box that displays specific information associated with the 
states that have been associated with the appointment. 

Appointment Link Allows a user to manually tie two unrelated appointments together for a 
particular patient situation.  Like with Protocols or Recurring 
appointments, the system will recognize these appointments are linked 
and warn the user if any action is performed on one of the linked 
appointments.  You have two options for linking appointments:  1) Link 
to an existing (previously confirmed) appointment or 2) Link to a new 
appointment. 

Appointment Schedule Inquiry window allows you to enter the parameters required to 
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Inquiry view the schedule associated with a specific person or resource There 
are four available options for using the Schedule Inquiry window: Person 
tab, Resource tab, Location tab and Request List tab. 

Appointment 
Location  

The physical facility, building or ambulatory location where the 
appointment will take place. 

Appointment 
Request  

A request to book an appointment for one or more resources. 

Appointment 
Schedule  

A list of booked appointments for a person or resource. 

Appointment 
Scheduling Range 

Within the View tab in options, it allows the user to select the time frame 
that the system will allow the user to schedule - by setting at 0 and 0, 
there is no restriction (changing the default setting is not 
recommended). 

Appointment 
Synonym 

Within the View tab in options, it allows the user to select a single 
appointment type that they consistently schedule so that it defaults into 
the appointment type field (changing to the default setting is not 
recommended). 

Appointment Type  Definable reasons for patients to visit the clinic or location. Depending 
on the clinic or department, multiple resources may need to be booked 
within the same booking.   

Attending Provider The Attending Provider has primary and legal responsibility for the care 
of the patient during the patient’s inpatient admission or outpatient visit. 
In addition, the Attending Provider assumes responsibilities for placing 
tests, procedures, or exam orders, which can directly impact the 
patient’s continuity of care.  

Auto Discharge Outpatient Encounter Types will be automatically discharged (auto-
discharged) by the system.  The discharge date and time will be set to 
registration date at 23:59h. 

Availability Bar  Can graphically depict conflicts or available times during appointment 
scheduling.  

Availability Conflict  A system-detected difficulty in scheduling one or more requested 
appointments, which could be the result of person or resource 
availability checking. 

Batch Reschedule Simultaneously reschedules multiple appointments while by-passing the 
Work-In-Progress window. 

BC PHN BC Personal Health Number - Numerical lifetime identifier used in the 
specific identification of an individual client or patient who has any 
interaction with the BC health system. 

Block Scheduling  With scheduling blocks, you can determine a release time for that slot or 
block of time to expire into a different slot. Reports can be run that 
analyze the data to determine the efficiency and utilization of the 
resources reserved in these blocks.   

Book Properties Properties accessed by right clicking on the book, selecting book settings 
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and then properties. 
Book Settings Determine the view of the appointment book.  They can be accessed by 

right clicking in the appointment book and selecting “Book Settings.” 
Bookshelf This contains the Scheduling Appointment Books that are used to 

schedule and manage appointments.  
Cancel If this option is selected in the View tab, cancelled appointments for all 

resources will appear on the appointment grid. 
Canceled State  A previously scheduled appointment type that has been removed from 

both resource and patient schedules and no longer occupies time for the 
originally booked patient and resources.  

Cancelling 
Appointments 

The process to change the appointment’s status when a patient or 
resource calls to cancel an appointment. 

Check In A way to keep track of which patient has shown up for their 
appointments and which have not. It's also an easy way for a tech, nurse, 
or someone else in the department to know which patients have arrived. 

Check Out A way to track when the patient’s appointment is completed and when 
they have left the clinic/unit. (The majority of clinics will not use this 
feature). 

Client A Client is an individual consumer of healthcare services.  A Client can be 
a patient, resident or tenant. 

Client Identifier A Client Identifier is a data element that is used to identify a Client (e.g. 
Medical Record Number, Unique Record Number, and Personal Health 
Number). 

Clinical 
Documentation 

Clinical Documentation is the creation of a digital or analog record 
detailing a medical treatment, medical trial or clinical test. 
Clinical documents must be accurate, timely and reflect specific services 
provided to a patient. 

Consulting Provider Some hospitals may have the option to include consulting Provider 
information to record multiple or secondary Providers that are involved 
in the care of the patient. Depending on the hospital, physicians may or 
may not require hospital specific privileges to be a recorded as a 
consulting Provider. The consulting Provider also refers to physicians 
who are in a specialty and who have been asked to give an opinion or 
provide additional care to the patient. 

Conversation A Cerner Conversation is an electronic form designed to perform 
Admission, Discharge and/or Transfer (ADT) functions, tasks or activities.  
Conversations can use Rules to enforce mandatory entry of data 
elements, to conditionally show or hide data elements, or to format 
entry within data elements in order to support data quality or business 
practice.  Conversations may be accessed from different Cerner modules, 
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including but not limited to: PMOffice, PMLaunch or PowerChart 
Date Field Type  Date field types allow you to capture date information. 
Date of Birth The calendar date on which a person was born as reported upon 

registration. 
Default Location  Within the View tab in options, it allows the user to select a specific 

location if they consistently schedule to that one location. 
Default Schedule  One or more slot types that are used to predefine the use of time for a 

resource. 
Demographics  Information defined for the person or encounter. Demographic 

information includes elements such as the current location, alias 
identification values, age, birth date, gender, and maiden name.  

Demographics Bar A colored bar that spans across the top of the scheduling appointment 
book displaying patient demographic information such as name, MRN, 
date of birth, gender, age, etc.  

Disease Alert Patient information around a disease process that should be quickly 
conveyed to users to prevent possible transmission of disease.  It may 
not otherwise be easily discovered and may harm the patient, care 
Provider, and/or the general population if not know.  (E.g.:  Could include 
TB, MRSA, etc.) 

Displaced 
Appointments 

In situations where default schedule templates are modified and 
reapplied, or where slots are manually removed, use of a request list at 
the action of Displaced can be used to better accommodate the 
rescheduling process of displaced appointments. When appointments 
are displaced, the system automatically generates a request for the 
action of Reschedule. 

Once the appointments have been displaced, it is necessary for the 
appointments to be placed back into a slot. Compare each of the 
appointments on the request list to the displaced appointments 
displayed on the grid area of Scheduling Appointment Book. This allows 
you to see if the appointments can be shuffled back to the same time 
and resource from which they were originally displaced. Once the 
appointments are shuffled back into slots, they are removed from the 
Displaced Request Queue. Any remaining appointments on the request 
queue need to be rescheduled by contacting the patients. 

Display Binder An option to make the binder on the left side of the appointment book 
visible or not. 

Display Scheme  Display schemes enable users to define the display attributes of the 
following visual objects: appointment types, appointment slots and 
appointment books. 
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Display State  Defines the color of the appointment type as it appears on the 
scheduling grid and changes as the appointment type state changes. 

DOB Date of Birth - The calendar date on which a person was born as 
reported upon registration and displayed using the ‘Day-Month-Year’ 
format. 

Downtime  Any period of time during which the system is unavailable to users. The 
cause is not relevant.  

Drag-and-Drop Selecting the primary resource from the Work in Progress window and 
dragging it down to a desired date and time within the scheduling grid. 

Drop-Down List  A list box that displays a list of selectable values (drop-down list) when 
you click the attached down arrow button.  

Ellipsis  A symbol resembling three periods (...) indicates that another window or 
dialog box containing additional information will be displayed. An ellipsis 
can be used on a button, usually beside a box, or displayed beside a 
menu command.  

Empty Schedules If this option is selected in the View tab, it gives you the ability to view 
Providers that do not actually have a template or schedule applied for 
that day selected. 

Encounter  A single patient interaction and/or a specific visit.  In Cerner, an 
encounter is required before orders can be entered; results attached; 
and documentation dictated or attached. In scheduling, every scheduled 
appointment must be linked to a pre-encounter. 

Encounter Number  An internal number assigned by the system for each encounter.  
Encounter Type  Each encounter is assigned an Encounter Type to indicate the client’s 

current level of care, or the client’s visit type - the two main Encounter 
Types are Inpatient and Outpatient.   

EMPI External Master Patient Index (AKA: Enterprise Master Patient Index) - A 
Ministry of Health Services database containing demographic 
information and personal health numbers of all clients of the publicly 
funded health system in BC.  It stores in its own database, client 
demographic attributes such as name, address, gender, date of birth, to 
determine which records in different systems refer to the same client.  

Follow Up 
Appointment 

A secondary meeting between a health care professional and a patient 
for diagnostic, therapeutic, or consultative reasons, usually a scheduled 
appointment in a professional office. The meeting can be first time with 
the specific health care professional but must be related to an existing 
chief complaint. 
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Free Text Field  Free-text field types allow you to specify a free-text response.  
Gender Gender is the patient’s identification as either male or female upon 

registration. 
Group Appointment  Used to book multiple patients for the same appointment at the same 

time. This is typically used in settings where group sessions or classes are 
offered and the instructor only has one appointment on their calendar 
instead of one appointment per patient. 

Group Session  Prior to scheduling a Group Appointment Type, a Group Session must be 
created. 

Guideline Provide the scheduler with information regarding the appointment being 
scheduled.  A guideline window is displayed to alert the user; however, 
this does not prevent the user from continuing with the scheduling 
process. 

Help Files When you have a question about how to use something in the 
scheduling appointment book, or you see a message or error that you 
don’t recognize, you can use your Help Files to search for the answer.   

Hot Keys Pressing ALT + any underlined letter will perform that action the same as 
clicking with the mouse.  

Instructions Used to communicate to the patient instructions that should be followed 
prior to the procedure. Schedulers can review the instructions and 
provide them to the patient. 

Interpreter 
Required 

Identifies whether the patient requires an interpreter for 
communication.   If “No” is selected in the Interpreter Required field, 
staff must determine and enter in the Primary Language field what 
language the client is most comfortable discussing their medical 
condition in. 

Language The language that patient speaks, if not English. 

Large Buttons If this option is selected in the View tab, the icons in the tool bar will 
appear larger in size. 

Location The location that the patient is registered to. 

Location Group  A group of locations by which you can filter a list of tasks to be 
performed. For example, if you work in the locations 2N and 3N and 
these are defined together as a group, you could select this group when 
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requesting your list of tasks.  
Location Inquiry 
Tab 

Use this inquiry to view information (such as location with person name, 
check-in, group session) associated with a specific location in the 
Scheduling Appointment Book. 

Locks Sometimes a slot will become locked when a user has tried to schedule 
an appointment to the slot, but for whatever reason it was not 
completed.  The slot may appear open, but it will not allow you to book 
an appointment.  If you get a warning that a slot is locked, look to see 
who the conflict was created by, then have that person unlock the slot. 

Medical Service Used to specifically define the patient’s encounter according to which 
service is being rendered to the patient at that time. This field may be 
updated throughout the duration of the encounter. This information is a 
required field in Cerner, but is not required for billing.  

Medical Service 
Code  

A code that classifies patients according to the type of medical treatment 
they are receiving at your institution. 

Most Responsible 
Provider (MRP) 

Except for day surgery cases, this must be a physician who is responsible 
for the care and treatment of the patient for the majority of the visit to 
the health care facility (for example, longest length of stay).  The most 
responsible physician assumes responsibility for any treatment provided 
resulting from his or her written or verbal orders.   

MRN Medical Record Number - Unique Clinical Information System number to 
represent a single client and is also known as chart number. 

MSP Refers to the Medical Services Plan.  The MSP insures medically-required 
services provided by physicians and supplementary health care 
practitioners, and diagnostic services. 

Multiple 
Appointment Type 
Scheduling 

The ability to schedule more than one appointment for a patient without 
entering in all of the same information twice.  Once all of the information 
for the first appointment has been entered, select the Next button. 

Name The name that is supported by documentation such as birth certificate, 
passport or SIN (also known as Legal name). 

New Appointment A first time meeting between a health care professional and a patient for 
diagnostic, therapeutic, or consultative reasons for a new chief 
complaint, usually a scheduled appointment in a professional office. A 
referral from another health care professional needs to be received by 
the clinic. 

No Show If a patient does not appear for their scheduled appointment, the 
appointment status can be changed to No Show as a way to track 
patients who did not present to their scheduled appointments. 

On-Hold 
Appointments 

If this option is selected in the View tab, all appointments that have not 
been confirmed but also not cancelled for a resource will appear on the 
appointment grid. 

Orders to Orders to Scheduling is the process that has an order (which is placed in 
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Scheduling PowerChart) automatically generate an appointment request on a 
Request List in the Scheduling application. A scheduler can then view the 
requests and schedule them according to the Provider’s request. 

Outpatient An individual who receives services from a hospital, diagnostic and 
treatment centre, clinic or dispensary for medically-necessary diagnosis 
and/or treatment but who is not admitted as an inpatient and does not 
occupy an inpatient hospital bed. 

Override Suggested 
Date and Time 

Selecting this option tells the system to ignore the requested date range. 
This option is only available when scheduling multiple appointments 
where at least one of those appointments has a requested range 
defined. 

Patient 
Demographics  

Patient-level information that carries forward from one encounter to 
another. Patient demographic information includes data such as name, 
age, date of birth, gender and address.  

Peer Mentors Hospital staff that have been trained for a longer duration than general 
end-users. They have a good understanding of the system and hospital 
workflows and are great resources to pair up with. 

Person Comments Non Clinical information is communicated to the scheduler. 
Person Inquiry Tab Use this inquiry to view information (such as confirmed appointments, 

no-show, inquiry w/orders) associated with a specific person in the 
Scheduling Appointment Book. 

Personal Health 
Number (PHN) 

The Personal Health Number is a numerical lifetime identifier used in the 
specific identification of an individual client or patient who has any 
interaction with the BC health system. It is assigned by the Client Registry 
System to one client and may not be assigned to any other client at any 
time. 

Physician A registrant of the College of Physicians and Surgeons of British Columbia 
entitled under the Health Professions Act to practise medicine and to use 
the title "medical practitioner". 

PowerChart  The Cerner Millennium solution that is the enterprise clinician's desktop 
solution for viewing, ordering and documenting the electronic medical 
record.  

Preferred Name Name a person wishes to be addressed by or additional names the 
patient is known by. 

Preferred Phone The preferred phone number to be contacted at. 
Preparations Used to communicate to the patient preps that should be followed prior 

to the procedure. Schedulers can review the instructions and provide 
them to the patient or referring physician office. 

Pre-Registration Clients who are scheduled for a future appointment may be Pre-
Registered.  This will allow documentation and orders to be attached to 
the encounter prior to the client presenting.  If patient information has 
not been validated directly with the patient, these pre-registrations will 
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be placed on an incomplete status.  Once the patient has validated their 
information, the pre-registration status may be updated to complete.  
Once complete, the pre-registration will be sent up to EMPI. 

Pre-Reg Status An incomplete registration status is when the patient is not there in 
person and you are not able to reach them by phone. 

Priority  The priority is the level of importance assigned to the appointment 
requiring scheduling. 

Primary Care 
Provider (PCP) 

A Primary Care Provider (AKA:  Family Provider) is a provider who 
organizes and provides continuing care within the community to ensure 
a patient’s health is maintained. A Primary Care Provider can be, but is 
not limited to, a medical caregiver, a general practitioner, a nurse 
practitioner, or a fellow. 

Process Alert An alert placed at the person level in Registration - information that 
should be quickly conveyed to care Providers to prevent critical physical 
or mental harm to the patient or care Providers.  This information may 
not otherwise be easily discovered and may negatively affect the patient, 
care Provider, or others if not known. 

Proportional View The default and recommended view is Proportional View that allows the 
user to see all of the breaks in the day on the scheduling grid; the times 
are at the left hand side of the book. 

Protocol 
Appointment Types  

Enables you to schedule one appointment type that includes multiple 
appointments with 

Pre-defined time ranges separating them. An example would be when a 
specific amount of time must elapse between appointments. 

Provider  Anyone who can prescribe, or could be selected as a referring, admitting, 
or other Provider.  This includes Physicians, Midwives, Nurse 
Practitioners, Clinical Pharmacists, etc. 

Reason For Exam Only the actual reason for the visit should be entered here by the 
scheduler.   

Recurring 
Appointments 

Designed to help in situations where an appointment needs to be 
scheduled multiple times over a specified time period.  This type of 
appointment is most commonly used in the Rehab area where a patient 
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needs to come for therapy multiple times. 

Removing Slots To remove slots from a schedule, right click on the slot to be removed 
and select Remove slots. 

Referral  Request from one practitioner to another practitioner to render a service 
for a specific patient; typically the service is one or more a consultation, 
diagnostic test, specific surgical or medical treatment.  All referral orders 
will occur as outpatients only. 

Referral Encounter 
Type 

Used when a patient is referred for an appointment or service, and 
intake and/or triage is required.  This will allow documentation to be 
associated to the referral encounter, and could be transitioned to the 
appropriate encounter type if the referral is accepted.  

Referring Provider The Referring Provider is the caregiver who referred the patient to the 
facility. This is usually a physician but may also be another type of 
Provider (e.g. nurse practitioners, midwives) as long as they are 
recognized by, and are licensed by their respective college. 

Referral Received 
Date 

The date the referral to the clinic was received for appointment 
management purposes.  Depending on the clinic, the actual date that the 
referral was written by the physician may also be the same as the date 
received in clinic. 

Referral Source Indicates the person or agency that referred the client. 

Registration The act of creating, verifying, or modifying a client’s record or 
encounter(s) in order to ensure accurate capture of the client’s identity 
as well as record high-level information about where and when they are 
receiving service. Within Cerner, this is achieved through the use of 
Conversations.  

Re-Referral 
Appointment 

A meeting between a health care professional and a patient for a chief 
complaint that the patient was previously referred to for and discharged 
by with the same health care professional. A referral from another health 
care professional needs to be received by the clinic. 

Resource Inquiry 
Tab 

Use this inquiry to view information (such as displaced appointments, 
opens slots available, booked outside of slot) associated with a specific 
resource in Scheduling Appointment Book. 
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Request List Work queues that hold requests for a scheduling action to occur. The 
request list queues are associated with an action for the appointment 
type and then the location. Because the request list queues are 
associated at the location level, each location may have different or 
similar request list queues. 

The appointment request can be initiated automatically or manually in 
the scheduling appointment book or from an order in a clinical system 
such as PowerChart. 

Request List Inquiry 
Tab 

Use this inquiry to view information (such as request list by location, 
request by appointment type, request by queue) associated with a 
specific request list in the Scheduling Appointment Book. 

Reschedule To reschedule an appointment.   There are multiple methods for 
rescheduling appointments.  You can right-click on the appointment 
within an Appointment Inquiry, right click on the appointment within the 
scheduling grid area, or click on the Reschedule icon on the toolbar. 

Reschedule Reason When an appointment is rescheduled, the Reschedule box will open and 
a mandatory reschedule reason will be required. 

Resource  Any item with limited availability for which a schedule needs to be kept, 
such as a physician or an examination room. Resource is a term that 
covers a wide range of meanings and can be applied to location, people 
or equipment. 

Scheduling Grid This contains Resource (person, equipment, room/place) schedules. This 
is where appointments are scheduled and managed.  
 

Schedulable Item Any item that can be scheduled to a resource or person appointment 
schedule.  

Schedule  The process of creating an appointment request, booking the request to 
one or more persons or resources, and confirming the booked requests.  

Schedule Button Allows the user to view the default selections such as duration and slot.  
Within one window, the user can verify or change the resource, duration, 
slot, and time using the drop down boxes that display available options.  
This option is recommended for booking outside the slot (overbooking) 
only.  It is the least recommended method for booking regular 
appointments as users can accidentally book appointments outside the 
slot and allow for potential double booking. 

Schedule as Visit 
Within 

This option allows you to combine more than one appointment type as a 
single visit. This option is only available when more than one 
appointment is highlighted in the appointment window. After selecting 
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the check box, indicate the time range that the appointments should 
occur within. For example, if you set this option to 7 hours the system 
will search for times when both appointments begin times are no more 
than 7 hours apart. This setting is retained and will default the next time 
the suggest dialog window opens. 

Slot Time in which appointments can be scheduled for a given resource; it 
defines the specific time on a resource’s schedule for which certain 
appointment types can be scheduled. Slots are associated to a resource 
to visually indicate when certain types of appointments can or cannot be 
scheduled. 

Small Buttons If this option is selected in the View tab, the icons in the tool bar will 
appear smaller in size. 

Source ID A source application Client Identifier, typically an MRN or URN for clinical 
information systems, assigned by a source system and cross-referenced 
in the EMPI.  Also known as local ID 

Special Instructions A field that will provide any pertinent Notes to Scheduling. 
Status Bar If this option is selected in the View tab, a horizontal bar will appear at 

the bottom of the screen displaying Help, Domain presence, user login, 
Day, Date and time. 

Shuffle The shuffling feature is used to move around appointments on the same 
day, without having to go through all of the rescheduling steps. For 
example, if appointments are scheduled for a particular examination 
room, and that room is no longer available, you can display the 
Appointment Shuffle dialog box and drag the appointments from the 
unavailable resource to the available resource. 

Suggest Scheduling The system can suggest available times at which an appointment can be 
scheduled based on date and time parameters that you enter.  This 
provides you with date and time options from which you can select 
without requiring you to locate available slots manually.  This method is 
recommended for those areas where available appointment times are 
limited and also for more complicated appointments. 

Telehealth Health care services administered remotely via videoconferencing 
technology over a secure and private network, whereby the patient is 
seen off-site by a Provider. 

Time Interval An option that determines the increments of time in the slots and is 
shown in minutes. 

Toolbar  A window element containing buttons or other window elements to 
facilitate accomplishing a task.  

Tooltip  A description displayed when you move the cursor over a button in the 
toolbar.  



Patient Scheduling – Foundational Part#2 Training Manual 
 

 
 
Date: February 2, 2018 
 Page 96 of 97 

Triage Prioritizing patients based on the severity of their condition. 
VIP Indicator Designates a patient who, for some site-defined reason, requires 

heightened security and/or privacy.  The VIP Indicator enables 
registration clerks to flag high profile clients or encounters. This 
functionality is for clients who request additional privacy and includes 
clients other than celebrities, such as victims of abuse, incarceration or 
someone well known within the health organization. The VIP Status can 
be entered at the Person Level.  Once a client is flagged as a VIP, their 
identity is masked in certain Cerner applications (e.g. in FirstNet, the 
client’s name is masked with asterisks on public-facing tracking boards).  
Setting the VIP Status to Yes will automatically default the Visitor Status 
to No Visitors. 

Waitlist There are times in the scheduling process that after all accept format and 
order information has been entered into the system, an appointment 
time cannot be agreed upon. In these cases a request list can be used to 
store the information in the system for a time when the scheduling 
process can be completed. In this situation schedulers may select any 
request list queue. Once the request list queue has been selected, the 
information is stored and available for the scheduler to complete the 
scheduling process at a later time. 

Wildcard  A character that allows a search over a wide range of related data 
elements (e.g. * and %). 

WIP Work in Progress - the accept format questions are completed and 
moved into the WIP before being scheduled into the desired date and 
time in the scheduling grid. 

Worklist  A list of orders that need to be completed.  
Worklist Name  The worklist name is the name assigned to a predefined set of selection 

criteria for the worklist.  
Work Queue 
Monitor (WQM) 

A document management solution that enables scanned/faxed 
documents to be routed to specific queues for review.  From WQM, you 
can associate documents to patients and visits, making them available 
with the patient’s chart. This will streamline departmental processes by 
automatically populating work queues for processing and also eliminate 
the need to print and scan documents. All paper referrals and 
documentations will need to be faxed into WQM with CST 
implementation. 

7/24 Access An application which allows designated computers to provide a snapshot 
of patient data for use during a downtime (e.g. Cerner 
applications/network is unavailable). Selected information from the 
previous 30 days (current inpatient encounter specific) will be available 
for staff to view during downtime. Appointments scheduled within the 
next 4 days will be viewed in 724Access. 
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Appendix J – Work Queue Monitor (WQM) 
 

Status Updates 

CPDI Work Queue Monitor allows user to select a status on a work item. Status can drive 
workflow from rule based routing. You cannot add or remove values from this field.  

 

The Various Statuses are listed below: 

a. New: Only new items entering WQM are displayed in a new status. 
b. In Process: This status is generated by the system when a work item is opened in 

Work Queue Monitor or Scheduling. 
c. Available: The system automatically changes a status from New to Available 

when the work item has been opened by the End User. End Users can also select 
this status in the Add/Modify dialog box.  

d. Clarify: This status can be selected in the Add/Modify dialog box, but it requires a 
status reason.  

e. Faxed: The system generates this status when a work item is faxed outbound. 
f. Complete: Once this status is selected in the Add/Modify dialog box, and you 

clock OK, the item is released to the patient’s record. The item is no longer 
viewable in WQM. 

g. Canceled: When you select this status, a status reason is required. 
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